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5 RISK OF ELECTRIC SHOCK l
DO NOT OPEN .

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK.
DO NOT REMOVE COVER (OR BACK).
NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.
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RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK.
DO NOT REMOVE COVER (OR BACK).
NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.
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LICh AF2EH 4 QU= AN Dh2to| s 2Ol A HAjof w2t H e
Ct=SLC}.

— o = s = =

Ut HO|A HEY S& SalEffect)E 0|23t

o
o —
at wola(ety] HAlel Ales)= 2o srel 24 | AP E SFAF

(Element)2 LM E £ JSLICH F 7tX| A9 HolA Chobst O|ME| 7} OFE 0] QUOf, 7|2E AXZ 9|sH MEY
BE(Volce Fa sP10 A=A, 42 24 DT S| ot mojLof 2lus W A KAS HY S UsUC,
AN HES /St 38 HENHE 24 HES St D3| ME EO0|A0 2= S0t HASME SA| C}2
HEO| Y&LICH @A WMEIS SO0 XS/S70XS ofC|E =2 AP E 7} ot=o|EIL|CE ofgf X|ES Za|ME H0|A
Jaof LIEH S0 HEE 4 J}SLC MEr 51t S35 a3 oieto|EE MAST o] MA
AT A4S0 S aHe Y Mol HAE 4 UASLICH XPMIEH AE = ARSAH EolA0 ME5h= WHS AF LT
2'24 ¥ =2Y'S FXRSIAIL
1 [VOICE] HES &38| B 0|A HZE(Voice Play) &

= JX| gAlol =& Ho|A HWE(Drum Voice Edit) &HO0|

ol=r|, HO|AQ| IE =2 7|0 M2E|= MK HES 9

AN 3 [— ES =2

528 BT S J(R4) B2 24 Byyol | O L0 T.:: HTvuLIEE(: Select) 3/ o
HOo|A HE! MEH(Voice Edit Select) £t™0| LIEFEL|C}

Ql&LICH 7| EL S90 XS/S70 XS Ol CIE 2 12 Ao | & A= ) SHE0] HErE G

LI‘EI‘H @'%Dl_f .\EE%EI- _JIK_ ?}lﬁl-" I:l' mnummun Ed|t SE‘IE‘Ct

[ Hame | [Play Mode| [Arpeasgio]
[Controller] [ LFO | [Fiter/EG|
2438 ELIEIA)| Effect |

RaE HolAo et 7|2XQ) £|A HRE, AT ARRES PRESS CENTERI.
ool o421 Z7HX| m2tolE(oll: £2F EG)E M &38| THEL
Ch ol 27|19 2t HOolA= O A2 FHE0f UELICH

S90 XS/S70 XS AZ HMHA



HO|A(Voice) REOAM F|IHE &

0

4 7|ME "Effect'2 §2| £ [ENTER| HES +5 8 FMZ "Preset'2 27! £ HI0|E| ClO|U R s

L|C}. Za|MEZS MEedStL|C}.
Ho|A MWE| S 1K(Voice Edit Effect) tH 0| LIEFELICE Za|MEo= S| MESSH S} SHAlo| CfEt UHER O]
mtatole Aol ZEELICH ChASt ZEHMEE Al
REIHE, common  Effect stof 217 AR SO OfEA BES FEX Yok 4
Ins Connect Tupe " ins & -> B A& Lct.
[@]-[Chaorus [3]-[6]0]
Bl [Eevertl—R] KBTS, COmmon v Ins 4 175 B
Tupe : YCW Phaser Stereo
Switch el
) Cateaory Fhaser
E1 ot=2mx|2/FnHArpeggio/Effect) 7150 "Eut AR/
(EFFECT ON/OFFy'22 MHE ZAL, [SHIFT] HES £2 &
[INS] HES =3 20|A M7 Fak(Voice Edit Effect) C|AS

Ho|2 23 4= sLct

fifo

5 71ME "Ins A2 §71 $ [ENTER] HE St HA0| MBEOf UE T2t0lElS MREHoR

LIt W50 ¥5H AFRES HoMAIR.

S 2 ote| oi2to| e 7t A E L o

PITE S, commonsIns & 275 E|
PIai0e=l, common  Effect Tupe : MCH Phaser Stereo
Tupe - WCH Touch Wah Speed

n-- 2 —[3]- |Ehn:-r'u5 IR

—|In5 B][2]- IEe'u'er'I:-I—I'ﬂlIﬂI
PRESS [ENTERI.

. 125Hz

Feedback

P00, common $1ns & 345 a

Tupe | YCM Phaser Stereo
(? ode
Color

P, common«Ins & 1/5 E|
Tupe . YCH Phaser Mono

ENTER

=Lk

Spread

Tupe YCM Phaser Mono

Preset E Piano
10 metojeis M5t 5 [STORE|HES S8 MH
6 9"*"% ||Categoryni %?_' § E‘||0| El EI'O|°E.|§ % AI‘%II‘ EOIA(USGF VOICe)OE x‘lg'—':'!'Ll EI‘.
St FhE| 2|2 MEdStL|C}. DM E 20[AS HHSIH HES LHE2 MEX HO|A
< == = Mg
PRI =i, COMMON »Ins & 145 a _
Tupe | YCH Phaser Mono [ aoice Store ]

FRE1_B3&

WCH Phaser i
Preset S TRitEiEE G

PRESS [ENTEF] TO STORE.

7 HAME "ype'22 ®7! 5 ©lOE| CHOIUE 8 | 1y
ot 51 Al ME Lt

(S I — |

HiolE| Cio|EZ cCHy ME=EZE ﬂ H5t
[ENTER] HES =8 &2l HIAIXIE 222 =
mﬂﬂmmﬂﬂdns 4145 a CiA| [ENTER] HES +=ELICt.

Tape | YCM Phaser Stereo
Switch

L
kJ
it
1]
vs)
ol
1=
Ui
1]
ika]
9'|_
o
ra
40
o
my
L=
omn
ne

PN g
=

1jo

gt

FPreset Deep Sweepar
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HOo|A(Voice) REOAM F|IHE HFE

— | -
OI2HX|L 7|5 AIE
Ol=2H| X|2(Arpeggio) 7|52 HFst= LEO w2t oz
MYE o2 X my o=, 2|= 2 2|5 HE S X5
2 s Alguch
Xl otAT I A 2|E AXE MB5HH IAWS HIEoR
HEE 4 QS # ofLz2t ot =M X|M OB L= 1
= MIDI HIO[HE = 2ol 0|8 4= T, 2tojl2 A
ZF A B HiE HIRE Zol & £ UASLIC 2 2olA0
Pot= ChA 7HX| o2 H X 2 Al XIFE £+ UL Ch
Ztzto| MEHA/HE|Q| 2t mtE| |5t= CHAM 7tX| ot2
H X A2 X|HstD |t 47 THEQ| OI2HX|RE &
Aloll RHA4EE 4 QuELCt.
Ol2H K| RiAY ghed, R AIE| 2fQUX| Y HAF &
5t AtAMTHS| HEHAS Ot 2 QUHL|CH £
22X HAES MID A
HX2 HOHE 528 £+ A& ot

O
<
o
Ofm
ol
i
o
ol
2
>
i

Ol2EmX|2 7{7|/117]

Ol=2H X2 MMS 741 n2{™ i 2| [ARP ON/OFF] H

2
== T8I

COMMON PART SELECT

L B B B |

I .

ARP
ON/OFF PART ARP

HOLD

OIZH X Al Mey

Ol2H| X| 22| {442 MIDI HIO|E{ 2 M HMS
CHe M2OHEE "'ON'e2 MFFo= M Ot2HX|2 =
3 0|=Z MIDI HIO|EH 2 M &8 4 ULLICH

B HO|A o254 X|2

H0|A(Voice) BE > [UTILITY] > S=alE| Mei(Utiity
Select) C|AZ 2| 0|0l A "Voice" MEH > [ENTER] > SE 2|E|
Ho|A MEH(Utility Voice Select) C|AZ 2| 0|0l A "Arpeggio”
MEH > [ENTER] = "Arp MIDI Out Sw"

B OEEMHA OIEH XL

mEHA(Performance) 2= - [EDIT] > HEZHA HZX M
El(Performance Edit Select) C| AZ 2| 0|0l A HE THE MEH
- [ENTER] > m{ZHA Ot mE| MEH(Performance Part
Edit Select) C|AZ2{|0]0i| M "Arpeggio’ AMEi > [ENTER] >
Ot= M| x| MEH(Arp Select) C|AZ2||0]0f| A "Arp Edit" MEH
- [ENTER] = "Arp MIDI Out Sw"

B HE| O} 2 5| X|2

HE|(Mult) 2E > [EDIT] > ZE| ®E AMEf(Multi Edit
Select) C|AZa|0| T} E AMEf > [ENTER] > HE| I} E T
MEH(Multi Part Edit Select) C|AZ2{|0]|0l| A "Arpeggio” A
EH > [ENTER] > OIZH|X|2 MEH(Arp Select) C|A S 20|
Ol M "Arp Edit" A& 5> [ENTER] > "Arp MIDI Out Sw"

Z3 "Arp MIDI Out SW'Qt Z2 tHOf| A "Arp Transmit Ch(0t2 1| X| 2
M

S M) =S HE, MSMDIAHE S XY + ASHCH

OI2H X2 7

S90XS / S7T0XSof|= AIC|AFO| A, IO}, 7|E}, H|O|A 7|
Ef, §iot7|, EH 52 1St 6,779702] ot2H X|2 7} Of
Ao JSLICHIBE SR 2]).

m S90 XS/S70 XS AZ HMHA

1 Eo|A(Voice) 2E0|A [EDIT] HES SEL|C}.

2 "Arpeggio"E MEi3 S [ENTER] HES S EL|
C}.

3 7|M HESZR "Arp Select"S MEf 5t
CHO|2iS o=l Arp1-5 M = 3iLt
Lick.

mnnmmnn Arp Select
Arp Sw off
Arp Select

[ Are Edit |

=

rx
72 o
o m

i ol

5 ARF
[ Are 1 Tare |

4 7{M HES 0|25 "Arp1-5Type"S MEiSt S
[ENTER] HES F=ELICt

m::ummun Arp Select E

Arp Sw off
Arp Select & SEF1

Are Edit ]| MELCREECN

PRESS CENTEFR].

S diolg cro|¥2 olgsH miQl FtE|mal/ste] FLE]
12|/& Al(Main Category/Sub Category/Type)2

tHZstof E0t5H= WE S HELICH

IETEITE =, comman Arp 1 Type E]
prefess FC_Hie Hoe 1 _ES

Oraan

kain Ctar4

Yel Rate
GTime Rate +E3H




6 2st= mEZ 2 £ [STORE] HES 53] &
YE MEX EO|AE XFeILICL

CI2 OI20|X|L DIEo Ol2m|X|2 A
X

ol XIZloll mat Arp 10il KIHE Ol2HX|Q BAIZ Ap2-5
ol ZAHEHLICH

1 ot2mHx|2/E3 715 HES E8 "ARP SELECT"S
MEfiLict.

2 Function [1] HES SSL]|C}.

3 [STORE] HES =2 % 7|55 [2] - 5] HE 5 3t

LE =St

OIE2HIX|2 A HY

_E' >z

74X A0l Ot2H X2 E HASHHH o2 I X| 2/
7S HHED 7|5 HES AEEUCH

P o1

Ol2MX|Q/E3 7|5 HE

A
l =~ @ ARP SELECT 1 2 3 4 5
O EFFECT ON/OFF INS CHO REV MFX MEQ

1 {22l [ARP ON/OFF] HEES &2 Ol2H X2
£ gLt

2 ol2HX|/57} 7|5 HES £2{ "ARP SELECT"

3 15 HES ALSsl Ol ZHIXI2 HAIS HASLICL

HO|A(Voice) REOIAM F|IRE &H

S90 XS/S70 XS Al MEA



Z0}5ts HO|AS 0|

250 A H{EHA

= 27|= 20|A(Voice) 2E0]| = E0t5h= E0|AE 0[Es A AF

2|5t H0|A MA7IS SMOE BT 0] 7|52 Ho|A BEE matnl

A0 EAISIO] XEHS| 25H=
0Of(Layer), AZ2!(Split) & =&

ruOI' [I|0 |I

2|0]0f - CHE EO|A =hH| A=

o MM 7|HE Heto| M CHE HO|ATL &7 B8 02
S oIFE MASHS WHS MEELIC HEHAS Us

—= L a0

ojoteot 7|7t &5 0|2 SRotL FE2 3

1 Ho0|A(Voice) ZE 0| A VoiceZ MEHStL|C}.

mﬂi FEE 16881 (461]

Categqory: Pjano <A poo:

Matural Grand $6

| [LAYER] HEE F+ELICt
ZM(Category Search) 30| LtEHHL| T

o0E
M
g |0

H

Layer k
Main
Sub <ALL>

>
[
Hl
oII
OII

| 55101 (0|0 S BHS FEmalE M
UE % M (] MES £ELICH

Strna  <EnsEm:

mall Section
mall Ensemble
Imighty ;

edium Section

T
AADAA
mmmm
[ == = =¥
EREEE
-JaCn
= F-0000

S90 XS/S70 XS AZ HMHA

S22 A 2 = UAs

e LICH HEHA M
FH(Drum Assign)e| M| 7HX| Ha|st 7|sS

4 2Eo|M HsHs Ho|AE MEtE

EMssU=zH PERFORMANCE CREATOR
B ME(o: 2hHS LAER  SPLT  ASSION
wazl=ao T

for

[ENTER] H

e ™1
£ FELCh
M HA HM(Performance Play) st™O| LIEFE L C.

ISR 16881 rz @
I:-EItE";I:II‘"J : - .

Mew Performance
“ns B oo B REU | | men_|

[STORE] HEZ =2 M4™Z (Performance)2
el

[ Perf Store N
USR1 EIEH

InltlallzedF‘er'f-:nrm

PRESS [EDIT] TO COMPARE.




AXZal - oF AO = o 4 FHME"LO/UP'SZ §71 5 Y5t= HO|AE 7|
—=x "o "'—';E F e HCo| SIEHE e ATHRO| KIHEK|S MEd
CIE HO|A AHE LIct.
OlMds 7[Rt & 25 5 AER4 22LE82 LW e (SR 1anl 2 F
A= HEHAE OteE = giHE MAHEFIL|CH fI&R 9| 7t i Split ¥
¥ &2 88 A3 HUER BLIL) 0I5 Soi, 02 0 T
EHAS HS0 ALEC2E= H0|A MEE, QELCE Sub ZALL:
L 0ot OIEE HEE 4 Q&L ot SPLIT POINT ____ L @
LocuP T
1 =o|A(Voice) ZEON H0|A(Voice)S Med gt AT gl HO|AV} £ HO|AO|H Az £ HO|AS AZE &
L|C}. OIlEE LO/UPS MAsHE BIGHK| 2&LCh
IS, FRE 1 :8330C61) _ o
Cateqory: Kewe cm S FME "Main"/"Sub"2 §7| & B3t= HO|AE
Lategoru. keys  cer: ZeHet stE DS ME gL
Hard Vintage
T (ISR1:AR1 re [
lul‘—.
[ s cho J REU | mED_|] Split k
Main Bass
I =
2 mjgo| [SPLIT| HES &Lt e
AZ21(Split) 3tHO| LIEHZ LT} LOCUR LOWEF,
FETa IISR1:AR1 el
¢ Split 6 M [>]HES S=ELC}
! Ho|A 2E0| EA[FLICHL
Hain [IEEEEE
Sub SALL*
SPLIT POINT L 3
LO/UP LOWER Bass <A BASS:*
EEE% %%l%i EFD_D'FI'EﬁDDUStiG aF 1
n n = T J— =l =]
3 7{ME "SPLITPOINT"Z §7!| & AZ3l ZOIE PEES 115 Meaa dcoustic Bass
2 MxstL|C}. GM  A23 Acoustic Bass
= ISR 1:AA1 @ 3 o
T 7 S=0iM st HolAE Mest & [ENTER] HE
T g %&8urt
Sjll:-n R e HEMHA X{A(Performance Play) 30| LtEHEL|CE
sPLIT POINT -
LO/UP LOWEE USE 1 :@@1 re @
[SHIFT] HES =2 NEjolN 7|RE0] sts 28
So AZE EOIES AW 4 &L New Performance
D AZa moER MHE SS RS0 Attso| TEtE|of Q) [ 1ns | ceo [ rey [N mEen |
&Lt
8 [STORE|HES =2 X2 HEHAZ NI
L|C}.
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C3 SIS HO|AR £ | =3 IHE(OI2HXIQ HA)
— =
 OtE g|0|0f 2H= 7] HZ
O] MM2 23X HolA0 (OI2EH XL 7|52 S8ll) = L3 gd 7152 A#ste =3 HO|AE TIE 40 st
HEE 2SAE = U HEHA QteE= BHES MHF T OHE 49| O2HX|QE 7{2loZ MAst 4 Q&L =
2 IS Mz E ™ E|(Performance Part

1 Ho0|A(Voice) RE0|AM VoiceS MEHEHL|C}.
5 mEHA xijA(Performance Play) 3t 0i|A{ [EDIT]

By, FRE 21125 (H13) HES SELICt
HEHA HWE! MEH(Performance Edit Select) C|A S

2f|0f 7} LIEFEf L T

FERF Edit Select P4 E

Category:  Guitr  <E.0sT>

Hard Ramp AS1&2

[ 1ns | coo | REy [UESRY mEL | _ Common
L1 b2 = ][d4]

2 ™ 1§ ol [DRUM ASSIGN] HE S %=SL|c}.

£33 X1 (Drum Assign) 2tH0| LIEFELICE S&/EFS! PRESS [EMTEF].
7|(Dr/Pc)7t ZHe|nelofl Xt 2 XIFHELCH 28 &2
01A7} IS 40 YD OIZHXIRI AE22 A | 6 52 o|QsH IHE 45 ME3t 5 [ENTER] HE
LICt 7| HEE HFTEH o2 H K| 27t A|ZHEL|C A
IEET= ISR 1:AR1 e A .
"EF Py
" Drumhssian v EN, Edit Select E]
Main | Common |

Sub CALLy N ¢ |

PRESS CENTERI.

3 HM [P HES SELCL
HO|A 2E20| EA|EL|C}

Dr‘."F'c <ALL> FERF PART  Edit Select rm
EEE EE% Enwergan&:laréjﬁlt . IR [Fi=s tiode] [Arressio]
BLE Bod Dﬁﬂeﬁtanﬁgrﬂ.t ' [Filter/EG] [2 Band EQ] [ Row Sw |
FPORE B85 Modern Bock Kit F¥ Send
PRESS CENTERI.
4 =220|M ¥5t= =3 VoiceE MEHSH S [ENTER = =
E(L" ia st OiceS el ] 7 5’-Ik|E | 5l "Arpeggio"E MEH# S & [ENTER]

mxZH XH*H(Performance Play) 30| LIEFEL|CH.

FERF PRRT _ drp Select P4 [

ISR 1:861 P 3
Category. fp Sw
arp Select b ARP]
Hew Performance [ ArcEdit | [Are 1 Teee |
[ 1ns § cho § ren | [ mED_|

8 7IME 0|25l "Arp 1 Type"2 MENSH S [ENTER]

HES FELUCH

FERF PART  arp 1 Tupe P E
pred 282 MC_Cool Funk

Sub Ctarg TREB>
Tape rredZ&s
Vel Rate +E%
GTime Rate +EE

m S90 XS/S70 XS AZ HMHA



9 dlolE clolY¥e o2l oIl FHE| 2 2l/5HS] e
112|/¢Al(Main Category/Sub Category/Type)2
HZSto Eotst= HHEH S HSLICH

PERF PART  Arp 1 Tupe P
predZes MC_Cool Funk

Main Ctar4a

DrPc

SYet HS2=2 Arp 2- 59| IHHE ._?éga* = AF UL
CHA JHX] A S0ilM OIZHIX|RE HASHH 7|5 H
E2 0|8sIMAI2. o2 X|2/= 1t 7|% HES =2
"ARP SELECT'EH & 7|5 HES +&Uth
OlZ2HX|/51 7|5 HE
I
[— ¢
|:| @ ARP SELECT 1 2 3 4 5
(O EFFECT ON/OFF INS CHO REV MFX MEQ

HEHA 0|5 X|H™
HO|AQ THEMHAQ 0|22 X|HSH £ 0] MF
[e]]

= X
HO|A/IEZHAZ XES

jo
Rl
0

1 mz=HA xjA(Performance Play) 32 0f|A{ [EDIT]
HES FELICL
HEMHA WX MEH(Performance Edit Select) C|AE
2[0] 7t LIEFE LI T}

2 7{MZ 0|25l "Common"g MEist 5 [ENTER]

HES =&

3 HME 0|25l "Name"S MEH5t S [ENTER] H
Eg &5}

4 "Name"g MEf$t
Sich.
01& X1 (Naming) tHEH0] LtEte L ct.

AENOI M [ENTER] HES &+

r l ot
M1 22456720 1540y CLERR
AECDEFGHIJKLMHOPGRSTUYINEY S
abode fahidk lmnopars tuwvwsaz
FR ==, " VIELML DN KT
PRESS [ENTER1 TO EXEC.

Hlo|E{ clo| L1} 91*1 HECSR fst= EXIE M
Eist S [INCl HES S8 s Z2XIE 3 E
L|Ct. MEHSE S XHE FASt2{H [DEC] HES 5+

gLt
Z|cH 20%te| Y2 Xt H

AHE Y23 3 [ENTER] HES SSLich.

Mo

[STORE] HEE +E&LIC}
CHAN AM2Xt BTt 2 72H0| EA|E L|C}.

[ Perf Store 1

USR1_BE1
LSkl [EER

Hew Performance
PRESS [ENTER] TO STORE.

W3 U D2

fufo

ME§ 3t 3 [ENTER]

[ Perf Staore N

USR1_@&1
Uskd [EEP

InitializedPerform
PRESS [ENTER1 TO STORE.

gtol i 51&H0| LIEIL £ [ENTER] HES +8

Z1 x| E(Store) FHHO|A [EDI *
HO|A/HZHA/ME| SHS AT 4 U

S90 XS/S70 XS Al MH

e



I ZMA (Performance) RENM F|EE HE

SXOo® HO|A Meinl SUSH YHO 2 BHL|Ch HED

3 | H} = A K A(Performance Play) ZEO| M E HZH
M 7|52 AFRE 4 Y LICH S90 XS/S70 XSOfl= TE|ME HEHAZF QO M 3709 AL X} 8 =0 K2 S| Ct.

& maae

PART ON/OFF

I .

ARP
ON/OFF PART ARP

I - -
|

HOLD

- -

HOo|AQ ES HE

HO|A(Voice) REO|A QL OFEIZIX| 2 HEHA(Performance) EEME 2 2 £210|HE Sall (X[t 4742 IE =
=olA2 28 HEPAS SHE MUY £ SSUL. HENL BT WYS T HEAL HUL HEAL KFE
IL EH

StLIe| £ ME(E0[A)RF HE Q| = JHX|7t J&LICE lHiEH* HEE HECSE HAEY _fEE M
BE3121 2 [COMMON] 1

i
ol
|.|-
o
ufn
i
[ -
r
ﬂ
SL
=>'.=
FE
2
>
_0
rn
z*_
H
o
[>
mjn
=)
ia)
Q'I_I
rﬂ J
— oo
5
>
v}
_|
w
m
—
m
@)
!
T

o
= T
=
T

it

T [SHIFT] HES %2 xH [COMMON]/[PART SELECT] HES S2 Z& M7 MEe(Common Edit Select) C|AZaj|0|/mtE ME AMEH(Part Edit Select)
| ol 3ot

o
re
1o
TH
]
mo
C
n
o
N
or
rlo
re
M
e

b 21Z0l U= 471 2] S2t0|H = 471 2] 2t ItEol| tish =& (VOLUME), M(PAN), Z2{A ™&(CHO SEND) & 2|t E
JELICH 220l 7|5 HELR 7|sE MEet = S2t0[HE Ssd UL

O voLume
Oran

(O CHO SEND
() REV SEND

[

ZONE 1 ZONE 2 ZONE 3 ZONE 4

e R=]

a0l 715 HESZ 7158 MeyELC

S90 XS/S70 XS AZ HMHA



1

2

S M 1'd o] MIC INPUT thXtof| olo|3 & HZASIL|LCE.

HZ I HAXI=E 12| [MIC ON/OFF] HEE +E&L|Cl.

INPUT GAIN ' 2 E 0| 83H 0to| 2 2!
PEAK =7} BA| HSI=S 23 Alole ZHE

12 xXEH|C}.

oo
i
_IT‘_

LH 7|5 HES S8 "010|3(MIC)"E MEist £ 280| XIFE LB E 0

O TONE CUTOFF RESONANCE ASSIGN 1 ASSIGN 2
\j O EG ATTACK DECAY SUSTAIN RELEASE

O EQ Low MID F MID HIGH
D (O EFFECT CHO PRESET ~ CHO RETURN  REV PRESET  REV RETURN

O MIC VOLUME PAN CHO SEND REV SEND

El

o [

L|C}.

0| 7|52 PERFORMANCE 2 =2} MULTI 2 E0A AFR 7S 8L c}.

| Q0f 2t B(PAN), 2 2{ A XA (CHORUS SEND) X 2|#{E X2 (REVERB SEND)0| X|ME & HE X|of

S90 XS/S70 XS A2 MHA



USB XM BXIE =3/AY

(O =3/T{EHA(Performance) B E)

QLR =2/MEHA(Performance) REO M= 7|HE HFES C|Q H0|HE 528 4 JUSLCHL =25 20/ o]
Be 2R USB XM &X|e RE ClHE2|L LHE SaiAl H 220 2O THUE MEE 0 U0 X|™et ME EHX[0A] 0]
QR TtUS AAME 4 UBLICt.

of WS YIS MSRE| MH| MBS HHE 4+ Y
S HE2 WX|B HGHK| Y =0IXT} =SH YER
LRI o4l MEBHIAIR. 0f ool Ms 2217 2ee
Mooz ML

ro 4 7{MZ "Trigger Level"2 871 & Ea|/ yag
— = XXt C}.
S' ’ﬂﬁ‘lﬂﬂf ilE;E:ﬁi%gﬂ:g”GHlE) ﬁE“E“E 7|2 E AZLEMIC INPUT AlS 20| (07| A M3
Aol ma= SSsh= gUs dauln. slee A E2|7 BHS 25k SAI =S0| AISELICH 24
2 DYE =S WA E D) T4RTIK| 52 & USL

f

T M
Ct. of2h X|H=2 USB M& Hx|of| 7|12E HFE =35t=

1 [AUDIO REC/PLAY] HES %=EZL|LC}.
QLR =8/HZ MEi(Audio Rec/Play Select) 3t 0|

HERELIT rEequdTTmE'::e = ]
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AT USB-MIDI =2t0|HE AFE o1 20| &H 7Lt HHolE
—1‘—°'”\I—IE} HEEA| 9] AOIEOIM Z|Al S 81015t 5 O}
CESHMAIL.
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A/ QL Z20| AFRE At0l2] RE, MY &1
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= o
HE| OtE ®&(Multi Part Edit) 3tHE o|2gtL|C}.

HFE0M DAW 273

1 (S90 XS/S70 XSe| E ML 0|EE E5 o1
2l5) E2iol MIDI £3 ZEE USB ZE 12
gLt
USBE S5l ¢gZ& mf "Yamaha S90 XS (570 XS)-1"tE
L= "Yamaha S90 XS (S70 XS) Port1"0l| &3 BEAIE 2
2igtLch

]
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=

2 ZEE oA DAWS| 2t E2Hof| MIDI ©|0| Ef
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MIDI E240f S5t
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o 2EOof M U

ro

Eh11 S90 XS/S70 XS Of|C|E{E 0|28 ZEE 0| A S90 XS/S7
QaIXIY YN MHE 4 UBLICH MY oY M
£2(97|2 95 Bz HIY + UL

o

XS9|
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m S90 XS/S70 XS AZ HMHA

L2ZELYN HAH MO
(Remote Mode)

S0 XS/S7T0 XS 1id &=2 S5 AEE S DAWAZE
Aot AZEQ] MCIAO|ME X O{sh= o< He|st &
Z(Remote) ZEE EZO=Z $fLICL 0|2 01, 7|Is HE
OR ZHE|Q DAW AZEY0| S ATHBXIE 4
I AFEO 0tRALL 7|IHEE ALE5t= CH4l o|O|E Cf
0|t [INC] & [DEC] HES A5 DAW AZE Q02|
& ?IRIE Mo = U&LICH

SO0 XS/S7TOXSO| fHA XH 2EZ DAW SE T2 139l
Cubase, Logic Pro, SONAR 2! Digital Performerg =&t
£ UAELICL 7|7] S o2 2|0l =) 5071 2] VST 7|7 &
EE HEZSIZ MEE £ UE&L|CH S90 XS/S70 XS A

OICIHE o|8all HEE HESS HESLICH

ro
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31 S90 XS/S70 XS HZ = E MX|5HH S90 XS/S70 XS & A oflC|Ef
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C|E{ 2} S90 XS/S70 XS AAEI MO = A LM Cubase Al2| X 4.5
0|4k} 274 S90 XS/S70 XSE AHEE 4= UELICH
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http://www.yamahasynth.com/download/
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XS/S70 XS ¥ =712 SHI=2 A MX|& L ct.

S90 XS/S70 XS M H

1 usB slo|E2 E8l =2
L|CH( 36| O] X|).

7171 dRE 22

2 [DAW REMOTE] HES &
2 EofZLict.

{ #1Z4(Remote) 1 E

3 [UTILITY] HES =3 SE2|E|(Utiity) 2EQ|
#Z4(Remote) 3tHE E2{ZL|C}.

Utility Remote

kEnb ¢ Sldr Dise Time
Enob Curwe

Slider Mode

Froa Change Mode
‘Velocity Meter

4 "DAW Select"E f5l= DAWZ MAStL|C}.

5 [STORE] HES &3] 0| XS MEEHL|C}
6 2 71700l HZAE HIEEOIM DAW AZEZ0f
E A|=HSHLICE
ZFEOIA DAW 4 H
0| RE2 Zt S8 Z2IHWE AR =0 28s= WY
= dE gL
EtT 590 XS/S70 XS2} Windows ZEE Atole| Alo]2 ¢1zo| Hal= A

Lt S90 XS/S70 XS7} QEtX o 2 ZtXt7| 7HX|H 70|22 CIA| HA
St7{LE S90 XS/S70 XSE CHA| i 2t= DAWZ} S90 XS/S70 XS&2
CEA| QIAISHX| ZEILICEH 0|2 AR0l= DAW AZEQ0{E Z=5t
11590 XS/S70 XSE MMt HZ0| M2 =A=X| &5 Fof
CHA] A|ZHSHMAI 2.

Cubase

S90 XS/S70 XS & A =& Mx|stH HHo| 22

SONAR

1 [Options] Hl52 Y1 [Control Surfaces]E MEH 5104
"MIDI Ex|(MIDI Devices)" &2 22{3L|C}.

7t

=
-

2 "Yamaha S90 XS (S70 XS)-2"= o= o
5 "Yamaha S90 XS (S70 XS)-2"2 =8 =i
stL|c}.

2 1)|.

N roll

3 [Options] H'=& €1 [Control Surfaces]& MEHSIO]
Z X ZEIX| EH(Control Surface) 2 2|3 L|C}.

4 [+] HEZ £2l510 "Mackie Control"2 MEHSI

2 L E E "Yamaha S90 XS (S70 XS)-2"=2 M35t
2 L E E "Yamaha S90 XS (S70 XS)-2"=2 M ™stL|C}.
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Digital Performer

1 Macintosh HAZE{2| Audio/MIDI MHAHNA S90 XS/
S70 XS9| ClEm|o|A ZE 28 E N0l ZE
20|I HASLICL E MLU2l|olE{ o] ZE7} StLidroll €
2 30 M ZEE FIIE CI2 ZEE 2ETo[A
ol gt

2 [Setup] H|%2= =11 [Control Surfaces]= MEN5I0] =
A ztx| HH(Control Surface) 2 22{3L|C}.

3 uESS
Driver MM oj| A "Mackie Control"& MEHSHL|C}.

5 nunit"al "MIDI"E ME5H= B A M "Unit" MMojl=
"Mackie Control"S AMEi5tT "MIDI* MMofl= "S90
XS (S70 XS) New Port 2" Met 3t |C}.

2l gLICt

i N

Logic Pro

1 [Preference] IHI-.-.- - [Control Surfaces] > [Settings]
= MENSto] 2 (Settings) &2 S2{SLICH

2 [New] H|% > [Installl2 Me§&tL|c}.

3 @0 A "Mackie Control"g MEHEH & 0|2 HEES
rHo = FIL Ch

4 miDI Output PortE "Yamaha S90 XS (S70 XS)-2"=&
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5 mibi Input PortE "Yamaha S90 XS (S70 XS)-2"2 M
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EE I_ "mult|" = ﬂE—ﬂ gl|-|_'| EI_-

7 Bank?} NumberE MX3I0] 5= =218 e
MEeistL|Ct.

8 [STORE] 2 =8| X=t =
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ot 843
9l MIDI £ H U2 0/H S 018 f DRAE 7|2E 7|5

= OfAEO| 7|™A7]= A0| E&LICH CTHE OtAEHE M
Biste Adtez HZE (8 MIDI E MU0l oAM =

st7| #

2IOUS HHS 4 QUELICH O WHS a2 ch
1 [MASTER] HEE =2 OrAE{(Master) RER

SOo{ZL|Ct

S90 XS/S70 XS AIE MY

e



OlAE 7|HEZ 0|2(0tAE BE)

3 [EDIT| HES +&L|LC}. 8 FMEZ 0|25 "Zone 1"S ME#SI
OtAE| ™! MEH(Master Edit Select) &tH 0| LIEFEL|CL. Eg =2||C}.
Z= mx| MEH(Zone Edit Select) 31H 0| LIEFELICE.

{0

[ENTER] H

MASTER Edit Select E

Common ZOnE Edit Select z2ONE 1E

mmmm WIEIEIR) [Fote | [Freset |
Enb? Sidr

PRESS [ENTER].

PRESS [ENTEFR].

4 "Common"g MEi3t 5 [ENTER] HES %=EL|C}
)

&5 HE(Common Edit) 3tH0| LIEFELICH 9 F&(Transmit), 2 (Note), Za| M E(Preset) 1
2|3 1= H/28t0|C(Knb/Sldr) 581 ZHZtol M =
MASTER common Edit Select E 1(Zone1)o Mx -léu"l—l E—I‘.

[(Heme | WEZEIET) [Zone 5wl

PR ek, ZONE T ansmit3 /S 2one 13

after Touch
Modulation

PRESS [ENTEFR].

Foot Ctrl 1
Foot Ctrl 2
S "Zone Sw"E ME#3t 5 [ENTER] HES FEL|Ct
ZE = A9Qx|(Common Zone Switch) 8tH0| LIEFL & (Transmit) SHH
L|c}.

20NE Mote zone 13

WS TER: WL =y E]

Knob/Slider ----

SE(Note) st™H

20NE Preset 2one 13

6 "Zone Switch"E "on"22 M $tL|LC}. Eviitl %EE g%g ggg
'L =2/&2t0|H(Knob/Slider)" mt2t0|Ef EESt on2 2 X} FLC 81 | 881 | aai
= el Yolume 166( 166| 166
S =od"w Ll I:l'- Fan [ [ [
HMIDISendSw | off
P ESSy gl che COMMON Zone Sy E I 3| M| E(Preset) 31H
kEnob /¢ Slider on TFi=aya= Z0NE knob/ Slider 2IJHE1E
] 18| 18| 1@
Slider a7l a7 av| av
D LH/2E0|HE H J|5/E r0|t1 759 HEEYZ o]
8% WOI= Knob/Slider® off2 FBHIC 1= 5/ a}0| ¢ (Knob/Slider) C] A Z#|0]
7 [EXITTHES F EE-'l OAE] BE MEH(Master | 1 [EXIT] I:H._E a1 Ot AE n._1 Z MEi(Master

=08 £ HEE

Edit Select a

____ Common | 11 5= 2= njajo|g = M5t S [STORE] H
[Zone 1] [Eane’] [ZoneZ] [Zoned] Eg =8 MYS 0lAE TE2IMO R XEHE

PRESS [ENTERI.

AH2 0l £ OIAEH B8 HE (l\/laster Common Edit) C|
O|'"Name"0i| Al Df*HOﬂ O|EE XIYgLIct 0l
et = [STORE] 2 &3 DFAHE yOpSgijualy

S90 XS/S70 XS AZ HMHA



SEZE|(Utlity) REOME 2 7(7]9] M| A|AH N HEE
HH [UTILITY] HEES SEULCH [EXITI HES =2H 2aj 3tH
o7IMe FERIE 2EQ AR K88t 7|52 dHFLICL

HESZ2Wr7I2 2= 4%

SERIE| BEEEZ E0{7t

o] M| &< (Micro Tuning)

General > Power on Mode

Ho0|A(Voice), I{ L M A (Performance), HE|(Multi) & O
AE|{(Master)ol Al TES HAH 7| M X|HE ZREE =&
St

[ #Utility General 4¢3
duto Load

LCD &EH HtH

General > LCD Mode
0| mato|E{= LCD MBS AXBILIC}

mﬁi FEE 1881 (461

Category:

Fiano <A Poo:

Category: Piano <A Poo: 4 o0

g(HER2z) 4E4Y

General > Click Sw - OutputSel

Y HERS)o HEZ 22 U = Qx|= HXS

= Utility General 5¢3

EBeat did
Temro SE
“Volume 1686
Tupe 1
OutputSel L&R

MicroTune
FIEEQ| Il S8 FL gLt

[ Utility Select

[ General [[ HWMIDI |[Contraller]
LEGIINEY[  Voice |[ Femote |

[Guick Set][Fanel Lock] [Fotry Set]

PRESS CENTER].

MIC INPUT StXI22E{ 2| MS
Eesut &4y

TETESES

Voice > A/D FX

HOo|A(Voice) ZEO|A MIC INPUT HHXF2EE o] AS ¢

Ho| d8E= g0t ¥ 2R dHE Z™ELcH
Utility Moice &7/ D Effect

E] I
Tupe . Thru

[#]———cHorus
|mﬂ£_ﬁﬁﬁ%h“ﬁ+

PREGE [FATFR1

-

HE 24H0|X|E &ESIMAIL.

Ho|A ZE0fM OtAE S3l/0tAE EQ 8F

Voice > Master FX, Master EQ

OtAE 230 HEEl= 20t H EQ M2|2s ZF &t

[_Utility VYoice Select

Arpeagio|[ A0 Out [ ADFX |
|I'.'Iaster' E(

PRESS CENTER].

S90 XS/S70 XS Al MH

=



Panel Lock

o2 o| [PANEL LOCK] HES =
S

HE
g+ U == HES Z2EEU
S

=o-d
AIE H7stel i &20| #Hx
AR E 4 UBLich

£ mjf "locked" E| 7L} At
LICH =l A Xl M &=
Atz sy HES

Utility Panel Lock
B all
— Transpose
— Humber 1-1&
HHI‘E M X
it £ A ™
I2|MENAM SILIE MEHEHO 2 M I EH A (Performance)
HE/™EE|(Mult) 222 9I$ Aol cHst oietole MEES
=22 4+ JUSLICH HE HAF HSTH MEHSHH 2] C|AE
glojoll U= metolE 7t MAEst ez ™7 2o ™
2IBILICH Ztzto| WiE M Hs ol &7| MY M2 O

N =g

e 48 Hs o4
1 Ot2HX|2 Hl0|E 0|Qlo] A Clo|HE ZHHEE
DAW AZEQ[0fol =S&
2 Of2HX|2 H|0|E{E =5l ZF dlo|EE HRH
O| DAW AZEQl0f0f =S8t HH
3 S90 XS/S70 XSE DAW AZ E Q||0{Lt CtE MIDI ZX|
of HESIK| 21 SR BX|Z AIRE of

[ Utility Select

[ General |[[ WIDI _|[Contraller|

[MicroTune|[ Voice [[ Remote |

el =Tl [P el Lock| [Fetry Set|
PRESS [ENTER].

S90 XS/S70 XS AZ HMHA




CIOIE M&E/22{27|(TtY 2 E)

I 2U(File) BEOI A= Of 717|0f A BLE HO|A 9 G170t 22 T 0|E{ 2 MASHD 222 4 ASLICH Y BEZ 5047}
243 [FILE] HES SSLict
Oi7|AE 2 717 AHBX HlBE|0f Y 2E Hl0/EIS Al TSI AL X2A)2 MAFHD B2 WS MHSLCH

- M 5 fust=rClaER|= MENSH S [ENTER| HES &+
USB X &t Zbx|of A& x|t aas ENTER
ofelg of ClalE2|of Xastai® 7 AE "NEW FILE'
1 uss Iﬂg_ X|& 2 717]2] USB TO DEVICE £t 2 0|=3t 5 [ENTER] HES L2Lc} 0fY Al M
Xtoll FZ@ELICE i 3tHO| LIEHELICH.

2 [FILE| HES &3 OtY 2EZ2 So{ZL|Ct

oty MEH(File Select) 3t 0| LIEFEL|C}. [_File Save "y

File Tere N

[ File Select N
PRESS [ENTER] TO SAUE.
|_Save |

PRESS [ENTERL 6 File 82 MEeH3t 5 [ENTER] HES +5L|C}.
2= HIOIHE XMAsta{™ "Al'S MEHgL|CL "All'S
Sl MEE HIo|EHE 2 7|7|2 CtA| 22{2tE Ho|H
3 FME 0|83l "Save"E ME{St £ [ENTER] HHE HA WO ofL|2t S HO|A Fi S HO|A #A 9}

£ F+&LIch Zo| At Xt SH= £ H|0|E{ S MEfSH & UL

otel X ZEH(File Save) stHO| WE SafA| H=22|2t

USB ME IXI7t AL 7 midof o|S2 X|H 3t 5 [ENTER| HHES SEL|C}
HIOlE] Co| QT 7 A HESR Ysts 2XIE Meist
File Sawe Z [INC] HES =2 Meist EXIE LHELICH MEY

re

=S #4062 E [DEC] HES +&U

M1 22456729 _ 154 CLERR
SECDEFGHIJELMHOPRRSTUNIEY S
abcdefshidk Imnoparstuvwxgz
R S C K N R rt i |

4 91*1 [A]/[v] H.I S USB I-lg gil% 'AJE_'HQ PRESS [ENTER] TO EREL.

% [ENTER] HEE SEL|CL
USB XM=&t xtx|9| 2E ClalE2|7} EA|EL|C}

File Sawve

File Sawe

O S9ERE . Kb

PRESS CENTERI.

PRESS [ENTEF].

S90 XS/S70 XS A2 MHA



HiolE M¥/2e{27|(u 2E)

USB X{Zt ZX|0f| A X S | © 2= dlole 42 duz 2 ENTER)

'I'|=| L-l El‘.
27' DEHOIAEEDIEH %LH_?_Al'%Xl'HoHHEE
Q8™ "Voice" L= 'Performance'E AMEH St

1 usB x=zt
- |

x|2 & 7|7|2] USB TO DEVICE &t
Xtoll A C}.

[ENTER] HES SELICH EX 20|A WALt HE
AH3E E23 2™ "Voice" EE= "Performance'S
EiStn 7 A [>] HES 2] fsts WIS Mefdt
[ENTER] HEES +ELICt.

X}

SA
%I-l
=

Job 2@ Ao ™

2 [FILE] HES &2 0tY(File) RER S0{ZL|C}
ot MEH(File Select) St™O| LIEF LT}

[ File Select N

WEEE) [ Coad |

PRESS [ENTER].

I 3tFHO0| ®AIEl C}S [ENTER] HES CHAl
LiCt.

4r Jtor
IIIllI ro

ol

3 HMZE 0|25l "Load"S MEH
HEZ S&Llch
ot 222 7|(File Load) 3tHO| LHE SeiA| K22
2} USB X & x| 7t EA| =L C}.

t C}2 [ENTER]

I

File Load

4 #M [AV[V] HES 2 USB M3 HxIg Mef
5 [ENTER] HEZ S5L|C}
USB MZ&H &x|ol R2E C|HEZ| 7 EA|IE L C}

rot

[ Fil= Load N

@599}:5 5'?9:-::5 mid

PRESS CENTER].

USB X &xlol BCiL CllE2|7} s HS HA
> HECZ A=E o|SELICH

= |c}.
22{2 4 Ut ool YA EAIED 0] 5 stLE
Meyg & Lot

-
H-EElS | | owi thout sastem
Nkl i ce
& =9Per formance
dll Arpeagsio

PRESS [ENTER] TO LOAD.

S90 XS/S70 XS AZ HMHA



HiolE M/2227|(1d ZE)

USB A& & x|

HE Ar|

stecla3z satol2 §
[ USB X% &3
USB E2iAl ol=2| [ E= |5 USB TO DEVICE Etxt

oVMAHA

ifi

= Sgexs

S90 XS/S70 XS

S USB &tx|

USB TO DEVICE 7{4lE{0fl= USB & &X|(0f: st=C|A
3, CD-ROM, S Hl=a| o 7|t &x)2He HHst
Ch. ZFE F|EEL 0IRA 22 USB HAIE ALY 4
YBLICH HA MYUH(SAE HROIN MY 2F) E=
R MYUSE(MEE £ o MY ZF) BE A8 &

UELICH

USB MZF ZtX|2 Foi5H7| X0l Yamaha CH2|® =

Yamaha Sl HOAA(AME HEM RREEQ S5 &)
ol 22lat7{Lt otz e EM0|X|E EESHIAIL.
http://www.yamahasynth.com/

1]
L

i

11 CD-RRW E2to|EE AtEsl 0] 27|12 HI0IEE 2212 & UX
HOIEE MEY += AGHT L Ho|EE AFREE TS
1 ARFE Q] CD-RRW =2t0|EE ALESH HI0IEE CDOl N&E
& A& CH

5

o ok

USB A ZF o x| =94

IOHE|X| 42 USB M &X|E USB TO DEVICE HYIE O
HAZSEHLE ZOHE|X| &2 o= USB TO DEVICE 7{4lE|
of A& USB Ex|of 2oH oY HE(Fle) HE/Z2H2
7|(Save/Load) ztHO| ZX| ZZ20f| "unformatted device
(usb™™)'2t= EA[7} LIEHELICE 0] ZR0l= oY =
(File Job) S}HOJ| A ZSH A S Al EHL T}

= =
T 9o ofloilM 3742 HRE(™)= ESHsH0F S TRIQ UM MSS
LIEFEALICE StLEol FX|of 2 7Ho| mHE| M0 Z&tE AR mhE|M ™

S Y HS QEZo| EAIELCH

USB TO DEVICE TtX} AF2 A] 9| ALEL
CHS AretE HAGHAIRL.

=
ATQ

HEE USB MT Hx|7t Xt#| HE0| U= B USB Hx|2| MAS A
1 117{L} USB #H|0| 22 HZA/22|5IX| OIMA|. 27| & AL AL
ALOI X7t HE 4 UAFLICH 247[7L C|OlEf HMIAE Sti= SoHoll: o
RE0M MY, 2E E<' AH| £F) USB #|0|2 2 E2[st7LE, ZRI0fIA
HXIE R7SHXILE, &% PR & & Fx[e| MAUS X oA T

A & B2 8% £ UZ FE|0 HlolE7 248 £ AL,

S90 XS/S70 XS A2 MHA m



StHEA H M XS

LCD FA| HH

All data is initialized upon power-on. ) -

Continue? "Power on auto factory set switch" I}2t0|E{ & Z Z4QIX|= EQIFfL|C}.

Are you sure? X ™ot e dlg AAX|E el

Assign Vocoder Voice to Part 1. I Z M A (Performance)/H E|(Multi) 2 E0f| A Part 10| Vocoder VoiceZ} Ofel AL, A/D & mEQ|

Continue? Output SelectE "Vocoder'2 MA&E | HEYH J|s(Category Search) slHE & 3H Vocoder VoiceZ2
MBS HRAX|IE =elgtL o

Assign Vocoder Voice. Continue? H0|A(Voice) ZE 0| M VoiceZ} Vocoder Voice7t Ol 4L, A/D @12 mtE o] Output SelectS gz
7|'s(Category Search) stHZ S35l Vocoder Voice2 MEHSH Z4QIX|E &fQIEHL|Ct

Audio Rec stopped due to lack of =2 20| 25 AIZE0f 2019 =20l SXIE 22 0 HAIX|7} LU

memory space.

Bad disk or memory. O MCIALO| Mol HZEE 2E ME HXIE A 4+ USLICH E ME ERIE ZLoM5HT CHA| Ao}
MAIL.

Bulk data protected. SEZ|E|(Utility) 2E M™o 2 QI H3 H0|E S A 4 &LICH

Can't execute. AMA = ME) 120 AICIAO|HE ABiE & glaL|Ct

Click off. Z2(HER2=)0| HX UAELICH

Click on. S(HERS)0| HX LU

Completed. XEst 22127|, M&, = E= J|Et 20| 22 A& LICH

Connecting to USB device... USB TO DEVICE Ztxtofl HZ =l USB & X|ZE QIAISL CY.

Copied Arpeggio type. OI2 M X2 HAIZ EAIRHSLICH

Device number is off. X HE7H AU L3 H0|HE ME/+ME 4 e&LICH

Device number mismatch. x| HS 7t YX|5HX| QL0F H A O|0|E{E MA/4AIE 4 gisL

Directory is not empty. HO|E{7} S0 U= ZECE AFIE £ SELICH

Disk or memory is full. Q& K& AR 7t 7S REM OB S o XMEE 4 SUSLICH M2 27 XA & X|E AFRSHALE X
XM EZREHHOIHE AXSIH HF 37HE HHEYAIR.

Disk or memory is write-protected. QA & AX|7F M| ES E|0f QU7LE, CD-ROMIL Z+2 ¢17| ML of#|Ql B2 7|28 4 glaLct

Disk or memory read/write error. Q& XMZE HXIE Q7| e MY B0l LRI SIS L C

Executing... 2|2 Ml ZSLct.

Executing... ***.wav QL2 =2(Audio Record) 7|52 £8ll @C|Q IS oS of O] MA|X|7} LIEHELICEH
e Ohd ol E L

Executing... WHE oiza|of 47| & uf O] HiAIX|Zt LIEFELICEH O HIAIX|7t A== S Me0| AZ HENE &

Please keep power on. XISHAAIR.

File already exists. XESty e otel 0|20 S2USH 0|22 Yol 0|0] Y&Lct.

File is not found. 2 MY HRoM 2= 2 Foil X|He oA g 3 4 &L

File path is too long. HE2E LEtHE=E 2X7F 42 27| {20 HBMASHE = O = ClHEZ|off HMAS £ &L CH

lllegal bulk data. H3 H0|E EE H3 QF HAIXIE $£AGE SO LRI et &L|Ct.

lllegal file name. X HE ot o| 50| HREIJUELICH CHE 0| YHotelA 2.

lllegal file. ECotzE X|IFE oS o] MCIAMOIXN7H AL E &= A LE Sl ZE0|M E312 & & LICH

Learning... ‘#Z(Remote) REO|M =2/&2t0|Hof chiet oi2t0|HE &t& £ o o] HAIX|Zt LIEH LI CH

Load All Arpeggios. Are you sure? ot (File) 2E0f| A "All Arpeggio'E £2{2 ZQIX|E stolgtL|ct

Load All Performances. Are you sure? o} (File) 2 =0l A "All Performances'E 22|12 ZQIX|E &QI&L|Ct

Load All Voices. Are you sure? ot (File) 2E0{| M "All Voices'E €22 ZQIX|E &olgtL|Ct.

Load All without system. Are you sure? ot l(File) = 0f| M "All without system'2 22/ ZQX|E &QlgtL|Ct.

Load All. Are you sure? ot (File) 220 M "Al'S E3{2 AQUX|IZ &olSHL|C}.

m S90 XS/S70 XS AZ HMHA



stHE

LCD FA| M
Load Seq Chain file. Are you sure? ot (File) ZE0| M "Seq Chain file'2 £23{ 2 X QIX|Z &tolgfL|Ct
MIDI buffer full. U= %2 MIDI Hlo|E{7t & Holl =40 Ma2|g 4 i&LIc
MIDI checksum error. 3 Oo|E £4Al & Q27 grMEiSLICH
Mixing Voice full. ol0] MEE 2olA 7} 2|0 EH S ZHF o= Y Ho|AS XMFYE + ¢ELICH

No read/write authority to the file.

Now executing Factory set...
Please keep power on.

Now loading... otdg ges SYLc

Now receiving MIDI bulk data... MIDI 23 O|O|E| & $Alstm U&LICt

Now saving... oS ME SQL|Ct

Now scanning autoload file... s 2212700f that X ME oS AZHGIT UELICH
Now transmitting MIDI bulk data... MIDI 23 O|0|E & &4lst UEFLICH

Overwrite. Are you sure? ME Aol 2 ME HX|Q HolHE EHMOE 20| £ Z0|H 0| RAS AlBSHE 22X &=
HAIX|JLIch 2ol what [ENTER](of) E= [EXITI(OFL] O)% FEut

Part x is used for Drum Assign. HZMHA (Performance) 2EE0A BE OIEQ| IIE AQX|7} on 2 MEEN U1 E &t 7|50|
CE MEE 9§t IE "X'2 AFZE U O] HIA|X|Z7} LIEFEfLICE

Part x is used for Layer. MEMHA(Performance) 2EN M 2E IEQ| IE AQX|7}onS 2 MAE|0f /1 20|06 7|50] 20|
Ol IEE ¢St It E 'X'2 ALSE [ff O] HIA|IX|Zt LIEH L CH

Part x is used for Split. I ZHA(Performance) LENA RE MEQ| ME AQX|7lon2 2 MME|| YT AZE 7|50 AZS
A ODEE I I E 'X'2 AH8E [ff O] HIAIX|Zt LIEH L CH

Please stop Audio Play/Rec. QLR £S/MF =3 £ MM Fols A=F ZHS AMas 4 l&Lct

Please stop sequencer. AHA AZ(SEQ PLAY) MM Zofl= AlE5 22 Mas & gi&L|CH

Save Audio Rec file? QrC|Q =2/HZF(Audio Rec/Play) REO A =S = 0jele XAHS Z{Q1X|2 stolstL|ct

Seq Chain stored. HA HQ MO MAZAS o 0] HA|X|7 LEHZ L] C}.

Sequence memory full. AEAE WE oi22|7t 7t XtM O o|&te] 2ig(=5, B, 2ty A&, MIDI £4/HS = AF X
I HX0M E2I27] )2 AH:E + glELth
SZLRS T, EH E= AFSXH Z 0| = |0|E & AX|S = CHA| Al=stAIR.

Set Part 1 Ins Sw to on to use Vocoder. A/D 213 mE 2| Output Select "Vocoder'2 MASH 1 HF M AMRE 9|8l Part 12] Insertion Switch
Eonez dygct

MIDI data overload. MIDI HIO|E{ 7} L5 H HZ& 4 gisLct

Store Voice? HO|A(Voice) ZEO|A E0|A HEO| HEZHA MAMT|(2|0|0|/AZS/EY &) 7|52 Adlst o &2
OlA HES NMEE AQUXIE &l

The received MIDI bulk datais type is not | &1z MEiSt ZEQ} CIE T =0 MIDI 3 H|O|E{E A5 mff 0 B|A|X|7} LIEFELICH H3 do|H

compatible with the current mode/voice | = T4 ZEQ SUS ZEZ SAEL|CH thal 9l THEQ| HO|A °“'(°'H* HO|A/ERY H0[A)0]

type. H3 HO M HOo|A AT COHE o= O] HAIX|IZF LIEHELICH H3 HO M& HolA A SY
St HOlA HACR X|HE thy MEE MEigLIC

This Performance uses User Voices. 232 A= AI2A HO|AE AI2FILICEH A A2t SUSH HO|AS SUSH ALRA W3 /HS0of X
e ARIXIE EolFL

USB connection terminated. HIEAEQl MER o6l USB MA Ax|etel ®Z40| Zojxi&LICh USB TO DEVICE 7{4/E{ol H USB

Press any button. Xy HXE 223 = 1d HES FEUC

Utility stored. SEalE|(Utiity) 2E0| MFo0| ME=QUELICH

S90 XS/S70 XS At
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S HEOolAM 8 LErXel 2ol et 24 shZ 238 A = HO[X|IE MAIZLCH HOIHE Y MY Fx[of et
= 3T £ A 23080 0|X))S HASIH ZHE liZsll = 4 USLICH EHM7F XS E|H Yamaha EHof T2 FO[|Lt AfH]
2 MEoll 2|5t Al 2(63H| 0] X|).

A2E7 S EIX| §4ELICH

B S90 XS/S70 XS7t 2C|2 A 0|22 Sall &d & J“'I(01| W, A0, sl EZ)0ll M2 HHEO USLI?
S90 XS/S70 XSoll= AT A7} LHE =0 UK FSHAl 2LIEISH| flsiME 20F U2 AA-O[LE AR
L EE0| EREL

Q
|0

|O

u O:
il
1o 3
OII

B = MOALO| M2 o710l HZEE ZE 2F X2 HHO| AKX USLINN?

ol
M
ACIAtO[X 2| OtAE 28 H HZEE 2 x| 28 43S Zolsto ZE AHYS HHEsHH 2FASHMN?
HEEHII 2™ Y& L 7HFOOT CONTROLLER ©HXtof| HZ | s H2)?
=

B 47}X| £2}0|C 7t 25 XAt 3#(0 L= | 0]2)= AYEO /U

HH rHI

B 2Z ZHAEE(Local Control)0] OFF2 MA |0 USLIW?
off 2 M™E|0 U= E2 LHE E MU20|El= A2|7t LEX| 2&LICH
[UTILITY] = MIDI = Local Control

VOICE] > [EDIT] > Effect

VOICE] > [EDIT] > Filter/EG

PERFORM] - [EDIT] = Common - Effect

PERFORM] - [EDIT] - Common -> Filter/EG

PERFORM] - [EDIT] - Part MEH - Filter/EG

MULTI/SEQ PLAY] (Multi 2= MEH) 5 [EDIT] - Common -> Effect
MULTI/SEQ PLAY] (Multi 2 = MEH) > [EDIT] -> Part MEH - Filter/EG

B Ho|AQo AlQl S Alo 2 "Vocoder"E MEHGHEL|7I?
O A AD 2 mtE U MIC INPUT AL E{Q 221 El oj2to| 6 S sy 222 MEFH S 2 0|AS S0 XS/S70 XSof
HZE ofo|=of LHSIHM 7|ZEE HFSHIAIL. THE Q| INPUT GAIN LB 7} 2[4 X2 A EU=X] &H2lshy
Al
[VOICE] > [EDIT] - Effect = Ins Connect Type: vocoder
[UTILITY] = [VOICE] > A/D Out - Output Select: vocoder

E

B EEO|Lt dAZyM AHo| LR FSLM?

UTILITY] = General > Volume

VOICE] - [EDIT] = Play Mode - Volume

VOICE] = [EDIT] > £2l0| 7|5 HEE &3l Easy Element Edit Mode > Sliders
PERFORM] - [EDIT] > Common > Play Mode = Volume

PERFORM] - [EDIT] > Part A& 5> Play Mode > Volume

MULTI/SEQ PLAY] (Multi 2 = MEH) > [EDIT] = Part AlEf - Play Mode = Volume

— = = = = e
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B Element Switch, Part Switch, Note Limit & Velocity Limit S2| mt2t0|E{ 7} M2 M™HE o] YUSLII?
[VOICE] = [EDIT] = [MUTE] (HE) > ¥ [9] - [16] HE
[PERFORM] > [PART ON/OFF]
[PERFORM] - [EDIT] > Part MEH > Play Mode = Note Limit Lo/Hi
[PERFORM] - [EDIT] - Part MEH &> Play Mode = Velocity Limit Lo/Hi

B I EMHA/HE|(Performance/Multi)o| M AF2E7 E2|X| &= A HO|AE Zt otE| X|™HSIFASL|7?
[PERFORM] = [EDIT] = Part AlE# - Voice
[MULTI/SEQ PLAY] (Multi 2= ME) > [EDIT] 5 Part M 3 Voice

B O EHA/HE|(Performance/Multi)o| M AF2E7 E2|X| = 2R 2t OlEo| &3 MF™o| HMAESIL|7?
[PERFORM] - [EDIT] > Part MEH > Play Mode = Output Select
[MULTI/SEQ PLAY] (Multi 2= MEH) > [EDIT] = Part ME{ = Play Mode = Output Select

= EIMUIIM AT B2IR| e B9 SIZ NTA 2 Sol &2 ZE/HY U Helol 2 TS S

SHAl M™ | HESL|7?
[MULTI/SEQ PLAY] (Multi 2 = MEH) > [EDIT] - Part MEH 5> Voice > Receive Ch

B HEMHA/HE|(Performance/Multi)ofl Al AFRE 7} E2|X| $= A< 2t TtE Q| "Arpeggio Play Only" 20| E{ 7} 7{ X

UESLI?
[PERFORM] > [EDIT] > Part A& > Voice > Arp Play Only
[MULTI/SEQ PLAY] (Multi 2 = MEH) > [EDIT] = Part MEH = Voice = Arp Play Only

MIC INPUT EtXIOJ A AR E 7L 2| X| &L Ct.

B Oio|3 ALX|7F 7AX™ USLI?

® 0to|32} LIC|ALO|X Atol2] A[O|=S0| MHZE HZEEO USLIN?

B [MIC ON/OFF] HEO| one 2 MHEE|o USLIZTHHZ I} 74X UA&LI7H?

B INPUT GAIN = E 7} Al "t Bisto 2 24 HM5|(X|A {X|2) Sot7F Y& I?
B A/D YU ntEQ| S HHO| HE IELIN?

LH 7|5 HESZ 'MIC" MEf> VOLUME =2

B Su d™o| ™MAFLIN?
[UTILITY] = Voice - A/D FX
[PERFORM] = [EDIT] = Common = A/D FX
[MULTI/SEQ PLAY] (Multi @ = AeH) > [EDIT] & Common - A/D FX

B A/D Y™ niES| =3 Aol HHEELM?
[UTILITY] = Voice > A/D Out = Output Select
[PERFORM] = [EDIT] = Common = A/D Out = Output Select
[MULTI/SEQ PLAY] (Multi 2 = MEH) > [EDIT] & Common = A/D Out - Output Select

2|% MIDI x| E Sl AS= 0| 2S35HX| &L}
B I XZMHA(Performance) 2 E 9| "Split Sw" m}2| 0| E{ 2} "Split Lower/Upper" Li2t0|E| ™2 7|7| XX 7| REE A
& mor ZkS st ct.

S90 XS/S70 XS Al MEA m



4ol HEX| 41 AL ELCH

o LS

m [ARP ON/OFF] HEO| 73l 22, HES 58 EAISS DAAIL.
B A|EA A (Sequence Play) 2E01 Z 2, [START/STOP] HES L2 AA|Q.

B EE(HEEE) 2217t AL LHE [SHIFT] HES +2 & [START/STOP| HES =3 &

A2 E7t i =E Lt

XIAZ|MA L.

B S MFo| ™MAEEL|N?
EF 480M 2HE AHESHH ARETHIE =& JUELICH
[VOICE] > [EDIT] - Effect
[PERFORM] = [EDIT] = Common - Effect

[MULTI/SEQ PLAY] (Multi 2 = AMEe#) > [EDIT] > Common > Effect

Ed 40z OtAH F0HE AEotH A7 AHFE = UASL CH
[UTILITY] = Voice > Master FX
[PERFORM] - [EDIT] > Common > Effect > Master
[MULTI/SEQ PLAY] (Multi 2 = MEH) > [EDIT] > Common > Effect > Master

m O 40| HHBLINW
ZE S8 Y| R 2@ A2ET =8 &+ JUSLICH
[VOICE] = [EDIT] - Filter/EG
[PERFORM] = [EDIT] = Common = Filter/EG
[PERFORM] = [EDIT] = Part A€ > Filter/EG
[MULTI/SEQ PLAY] (Multi @ = MEef) > [EDIT] > Part Mef > Filter/EG

re
%
2

B [ 25 O2t0jE 43 3 ol stLigtz HF =4 2380 o EE
[UTILITY] = General = Volume
[UTILITY] = General > L&R Gain
[VOICE] > [EDIT] > Play Mode > Volume
[PERFORM] - [EDIT] > Common - Play Mode - Volume
[PERFORM] - [EDIT] = Part ME{ > Play Mode > Volume
[MULTI/SEQ PLAY] (Multi 2 = MEH) > [EDIT] = Part AlE{f - Play Mode = Volume

A2t ZHELCH

HEARSHL| 7712

In

B MY M2EFIEE MY R AHA HYS S8l L= AR

ro
rE
=2
9'I_I
if(]
ra
1]
-
_I:I_

)7k 2ICIALO| X 2| Z|CH O} HO[AS =apELMI?

m 0| Z=20l= Sz 2 =0l A Mono/Poly mt2to|E{ 7t "mono"2 MEEl HYLch.
FEE AFsta{™ o] mato|H & "poly'2 MFsHIAIL.
[VOICE] > [EDIT] & Play Mode = Mono/Poly

[PERFORM] > [EDIT] = Part Al€4 > Play Mode - Mono/Poly
[MULTI/SEQ PLAY] (Multi @ = AEH) > [EDIT] > Part A& 3 Play Mode = Mono/Poly

S90 XS/S70 XS AZ HMHA



® R E2|E|(Utility) ZEO0|A T (Tune) mt2t0[E{7} "0" 0] 2| 22 MPEUSLINN?
[UTILITY] = General > Tune

B S E!2|E|(Utility) 2 =0j M Note Shift mt2t0|E{ 7} "0" 0|2| 2} 2 MHEE|JUSLIN?
[UTILITY] > General > Note Shift

m HO0lAVF HRE SHE NS B, Ho|
S AAHO| MBI

[>

o X!(Voice Edit) 2 =2°| O|M| &'<Y (Micro Tune) mt2}0| E{ | A MEHSE

[UTILITY] = Micro Tune

B EHIEHA/H EI(Performance/MuIti)?} 2= S2H™E xAiSH
2| Zte 2 MHEEASLI?

rr

A

N
_El
Im
10
Io

=¥ 0| S(Note Shift) mt2to| E{ 7} "0" 0]

o
.

[PERFORM] - [EDIT] = Part AlE# > Play Mode
[MULTI/SEQ PLAY] (Multi @ = AeH) 5 [EDIT] > Part M€ 5 Play Mode

S7t HEEIX| dSLIC
m REVERB X CHORUS = H/22}0|C7} 2| A 2 §HM35| S2X USLII?

[
fol

ot @Alo] ol StLtgtE "thru" = "off"2 MH™EE[0 USL|7I?
Zt 12| EFFECT ON/OFF mizto|E{7} OFF2 M- &0 JSL

ﬂ
HEZMHA/HE|(Performance/Multi) ZE 0| A O] 2X|7} LMSt= AL, 2IMM AL|X|(Ins Effect Sw) It2to| E{ 7} M|cH
2 M| P =X| E0ISHM A 2.
[PERFORM] - [EDIT] > Part MEH &> FX Send - Ins Effect Sw
[MULTI/SEQ PLAY] (Multi 2 = MEH) - [EDIT] > Part MEH - FX Send - Ins Effect Sw

H3IM Ho|A MEH Al HI 7} 2FstX| §5LICtH

B A/D Input Part7} "Vocoder"2 MH™E|ASLI7}?
[UTILITY] = Voice > A/D Out - Output Select
[PERFORM] = [EDIT] & Common = A/D Out = Output Select
[MULTI/SEQ PLAY] (Multi 2= MEH) > [EDIT] = Common = A/D Out > Output Select

t2tole & HESte UX| =l HE EAISO| LIEHELICH

HE[7I HE X0 HH

rr

B EE(Edit) R =7t H2Y MEfUX[EtE =H/E520|E Tt 2RO E S HOo|A, T XHA £
HEA|SO0| LEIHCHE HE RelstiAlR.

091'
oln
o
H
H
ra

£ HZA(MIDI Control Change) M| A|X|E Z&HgtL|C}. Ol2H|X|2
7

B 2H o220 x| A2 MIDI A
= A AE|D HE HEASO0| 3lH = Mt EAIE £ USLICH

=
28t X 2ojAQ

S90 XS/S70 XS Al MEA E



=X sz

OI=2H|X|2E AlZtE &~ GlELICH

B [ARP ON/OFF] HEo| & M3} L= SN | Y =X| EQl5IAMA| 2.
® MIDI Sync n}2}to| E{ 7} auto EE= internal(LH 2 22 Al2)2 2 MHEE|0] USL|I7F?

[UTILITY] = MIDI - MIDI sync

B AMEX} Ot2H X| 2(User Arpeggio) T AlS MEHHSLI7HALE Xt o| O Ef gl01)?

MRIf Ol=2 M| X|QE AtE5t2{ ™ MOTIF XSO M 2H=E A2 X} OF2H X|2 H|0|E{& HtEA| S90 XS/S70 XSZ & 2{2}0f

fLICE

|]:0II

[
ol

[VOICE] > [EDIT] > Arpeggio = Arp Edit > Note Limit Lo/Hi

[VOICE] > [EDIT] > Arpeggio = Arp Edit = Velocity Limit Lo/Hi

PERFORM] > [EDIT] > Part MEH > Arpeggio = Arp Edit > Note Limit Lo/Hi

PERFORM] > [EDIT] = Part MEH > Arpeggio = Arp Edit > Velocity Limit Lo/Hi

MULTI/SEQ PLAY] (Multi 2= MEH) > [EDIT] > Part ME{ > Arpeggio = Arp Edit > Note Limit Lo/Hi

[
[
[
[MULTI/SEQ PLAY] (Multi 2 = MEH) > [EDIT] - Part M - Arpeggio = Arp Edit > Velocity Limit Lo/Hi

# 3t (Note Limit) & A|7| 3HE (Velocity Limit) S O}2H| x| 2+ miajo|E{ 7} MESHH MEE o YSLITF?

B I EMHA/HE|(Performance/Multi) 2 E0j|A] O] A&t0| BHAligl= AR, Arpeggio Switch I2}0|E{ & &HQISIAMA| 2.

[PERFORM] - [EDIT] = Part MEH > Arpeggio = Arp Edit > Arp Sw
[MULTI/SEQ PLAY] (Multi 2= MEH) > [EDIT] = Part MEH > Arpeggio = Arp Edit > Arp Sw

OIZHIX|RE HE + §SLICH

B ZiHho M 22 MC{2tE O2H XL X{A40| HEX| 9o ™ [ARP HOLD] 1- 4 H{E S 2 Arpeggio Hold T}ta}0| E{ £ off

2 A‘lxi o}AIAIg

mEHAM X|YE HO|AT} BO|A(Voice) ZEMM2| AI2ES} CHE AFRES

B HO|A AFREE mHIZMHA(Performance) R E9| Hi2tn|E| MO HAME|J| W20] 0l HAZQI

ot o=

BA mEo| 32, /12 K22 Lol ANoics) 2ENIM ABE 4 SU mA0IE HYE SHol SUH M2C
7h ELICk "Send level"S H2I3 O|HE (& o) 432t B215H0] CHS SHHOIM H0|A BEO| MHS HEHA BIER
SAHE 4 UBLICH O] YIS 8310 HOIA BENAS IHPIXIZ HEHA BEOINE HolAT} S2aki L2

EE ¥4 YgUch
[PERFORM] - [JOB] - Copy = Voice
[PERFORM] > [EDIT] > Part Al > FX Send

ZHEE{ 2} S90 XS/S70 XS ALO|0f|M H|O|E| EAl0]| M2 =-S5HX| t&LICT.

B ZFEQ ZE 20| HESX| &S A|

o

®  MIDI 21/0t2(MIDI In/Out) ut2to|E{ 7} HAEst gt 2 M HE|U=X| 225t A 2.
[UTILITY] > [MIDI] & MIDI In/Out

S90 XS/S70 XSo| A& = ;.’=‘.'-‘.T'-,-E-| L} MIDI 2}7]|2] = H|0|E{ & XH 4S5t 2t = S90 XS/S70 XS

7|' AI"Z'EE I‘“ EHE == Ol'xl |.° = Ll El’

B S90 XS/S70 XS7} HE[(Mult)) REE HHEE|N USLIN?
o2l AHE S SAIO A5t H HE| RES MEISHIAR.

m S90 XS/S70 XS AZ HMHA



=M siZ
MIDI '# 3 i o] E Alo| MtH 2 =S SHX| L&LICt
I(Receive Bulk) @it2}0|E{ S off2 MXASHEL|7}?
F20[EE on2 2 MHESIMAIL.
HIZ S0 2M x| HE

L RCERS)
sHM CIOIES MEHCHH ©a

B3 4= Al(Receive Bulk)

=
[UTILITY] = [MIDI] = Receive Bulk
H S90 XS/S70 XSe| "3 Hx(Bulk Dump) 7|s2 0|
(Device Number)ol| S st HS & M HHof &Lict
A Z4 =l MIDI 2}7|2] 2tx| tHS 7} R E 2| E|(Utility) 2 E 9| ZtX|

[UTILITY] = [MIDI] > Device No

B M20| MIHE 0|20 X|X| Q= HS, S0 XS/S70 XS0l ™

tH S (Device Number) I}2}0|E{Q} Y X|SI=2 MHE| 0] USL|V?
[UTILITY] = [MIDI] = Device No.

MEE £ gaLch
Hot2{H M 7| HS & sliixlsHof &Lict.)

FExol

S7t AEEIT UAELI7? (HIOIEHE N

HIO|E| & 2| USB X

x|ofl 27| &2
AELIN?

m USB X% &x
EHX|7F M ES| ZoE|of AF2E|D
[JOB] > FORMAT

m USB X%t %
[FILE] > Save > USB X

PRSx| M S

ThUn

B 9r|Q DY HA0| Bt
S90 XS/S70 XS&= 44.1kHz/16H| EOl| Al AH|2| 2 WAVE(.wave)/AlFF(.aif)

st

HE 2Eo S0l

B S90 XS/S70 XS7} |- I(File) 2
ot 220 M L2 = [EDIT] H

S90 XS/S70 XS Al MEA



MS AL

S90 XS S70 XS
H = 88 74, WA M 51} 7R = 76, WA M F0t J|EE
(OII-IS E{X|/O ZE{E{ X]) (0L 4 E{X|/OHZE{E{X])
£ H{zlo]E = M z2l0lE AWM2, 25 O}E| 22/ 0| M T3t
=22
== Z|th SA 3 128 2
ZE| EH 16 LiZF IHE + 0fo| = 2 mE
Aol 456 MB (16H|E 2|L|0] OO 2 HH35} A|), 2,772 It
Hol|A I2|ME: 1,024 LHt HO|A + 64 EF F|E
GM: 128 2t HO|A + 1 23 F|E
AF2X}E 128 x4 (M3 1-3: Z2|ME I 0| M MEH 2 ZAL) d HO|A + 32 23 F|E
HEZHA AHZ XL 128 x 4 (X|CH 4 THE)
HE| A2 XL 128
= 18 S Al
& 1f(effect) ZIHE x 9 Al FHA x22 YAl AQIA B)x53 Al x8 EF,
HAMx1(QME STHAYBEE 25 AMR), OtAE 1+ x 9 ;*M,
OFAE O|Z2t0[X(SHHE), IHE O|&2t0|X(3 HHE, AHEIL)
AR M MM AlEA AF SMF(ZZ MIDITt ) 284 0/1 (X © &)
I 52 (BPM) 5-300
Haf AR 2 100
Ol2 M| X|2 TN E x6,779 EAl
A2 X x 256 S AIMOTIF XS2| A2 X} Ot 2H X|2 H|0|E £2{27| Al)
QL =2/4x = =2: WAVE (.wav/44.1kHz/16H| E/AH|2| L)
MM XHAd: WAVE (.wav/44.1kHz/16H| E/AH|2| ), AIFF (.aif/44.1kHz/16H| E/AH|H L)
7|E} OtAE AHE XL 128
4 Z(OtAH 7|22 M), XI1H 7tsst L E2/&80|0 4, T2 HEE
A XY J|s1 S8t Windows®&: Cubase 5, Cubase 4.5, SONAR 8
= ANEA ATEQ0] Macintosh®g: Cubase 5, Cubase 4.5, Logic Pro 8, Digital Performer 6
* 590 XS/S70 XS7t MOf5ts 7152 AR St= AZE Y 0fol| WHat CHE LT}
HEEY x| Hie & Fs20|d &, £2t0|H(4), =2(4), 2Y 7Hs(Assignable) st HE(2),
ClofE CHold, 4= AQ!
CIAZ 0| 160 x 64 =E 2 820/ E LCD
AH o} CEX} OUTPUT L/MONO, R (EZ = £tX}), ASSIGNABLE OUTPUT L, R (EZ& Z £HX}), MIC INPUT (25
EtX}), PHONES (& AH| 2|2 = ttX}), FOOT CONTROLLER 1, 2, FOOT SWITCH x 2 (SUSTAIN,
ASSIGNABLE), MIDI IN/OUT/THRU, USB (TO HOST, TO DEVICE), AC IN
AH| M™H 25W
37, 27 1,472 (W) X 385 (D) X 173 (H) mm 1,320 (W) X 385 (D) X 173 (H) mm
22.4kg 20.4kg
24 25 AC TE e, At HENM(2 X}, AH2 4B A CD-ROME L HEM I Hl0|H =5 +5),
DVD-ROM(DAW AZE 90f £ &)
FEAMEHEMYYNE 74 Y HY2 YHES 2T MIFELICH Yamahas AM 0 T ¢l0] SIMIEX| MZOILE ME AILS HASIHL JHEE £ J& LI X0l et ME AR,
7171 22 SN2 OE + A2 2 g X[H 2| Yamaha th2| Eol| 22lstAIL.

AA T HiEO CHSE 1 X]
£35 &34 SOOI TARZ M ELH GNU General Public Licenseof| (2} 2}0|MA 7 M2 5= MEQ BE 2B AA FEE Yamahaof| S £ U2 ALch
MP business unit PA-DMI Division, YAMAHA Corporation
10-1 Nakazawa-cho, Naka-ku, Hamamatsu, 430-8650, JAPAN
E= Rdo2 MBEX|L Yamahas 44 FE HiS HIE2 7Y &&= ASHLICH
* Yamaha(fE = Yamahar} @17}t X}) 0/2/2 X1I3Xf01| —IoH 2 HMEe AZEQofof 7hEt HA(FIHAM)SZ oI5t ofH 240 tisiAM = MAS X|X| =Chs WS FEHYAIL.
® YamahaZ} 274 EEHIOIOH 2| Xst AA FEQ| AR ENEIXI oto i Yamahas Y AA T =0 Cf X %
* OIS FAUM AA FEES CIREEE £ JUFLICH
http://www.yamahasynth.com/download/source/s_xs
e GNU General Public License0f| CHsli M= E = 9| 0|0|Ef 22(PDF 2AM)2 ZH13IMAIL.

m S90 XS/S70 XS AZ HMHA



A_II-I

-

BEET A AHE 18
| .

e e 23
LH IS HE 23, 33
OSSP 34
=

CE HO|A E I OIE] oo 38
EH2(SIMPIE) CIAZ O] cveceeeeeeeeeesee e 23
LS 17
E B EH O|A oottt ee e 21
L= N S S 30
=

BILOTO] e 28
[ = |

N = == TP 43
OFAE], S1F- HO|A BE e e e eeaeens 45
OFAE] ZIEE et 43
HE|(MU) EE et ene s 38
B e e e ae e 19
O] M| FE(MICro TUNING) weeeeeeeeeeeeeieeeeeee e eeee e 45
H

=L 17
EHS (NUmMber) [1] - [16] cooeeeeee et 14
BHT EHID e 57
== PSPPSR 17
e RS 46
A

AMERFHET e 21
A BB e s 29
L 11 RS 16
L I = L 57
o

(O] = S 26
(O] = = RN 26
OIE2HX|Q/Z2 7|5 HE e, 27
AZF(Performance) EE ...t 32
QL =Z/HFE(Performance) EE .oovvccveevveiieeeene 34
R e O = S 34
R A e 24

re

B 24
B 24
FZ(REMOLE) ELE ...t 38
S EIEIE] B e 45
(O] E= N I SR 47
K= 2L PSPPI 24
QHE EHO[A e s 21
=

H A e e e 35
L P 16
B V7 o] a1 I 43
Z7{5t7|(Favorite) ZFEI 2] coeeeeeeeeeeee e 22
=

e R 22
ZEE HIES] e 40
Zal- I E25(Click - Metronome) .....occeeeeeveecveeneenne. 45
E T PR 24
i

L R 47
B B = N P 24
o - Ot B = (Format - File mode) ...eeeeeceeeeeecnieenn. 49
e I v = 57
L 21
£ LSS 16
A

E N o I ST Y/ o= PSP 26
ATD T = D e s 26
[ARP ONJOFF] ittt 26
ARP SELECT oottt 27
[AUDIO REC/PLAYT ettt 34
C

[CATEGORY SEARCH] .eoiiiiieeie e 22
[COMMONT ..ttt e 32
(O] o - 7= T 39
D

Data LISt ceveeeeeee et 8
[DAW REMOTE] .eeeeeiiie et 39
Digital Performer ....oooieeeeereeeesee e 39
[DRUM ASSIGN] weeeeetieereeeeeieeeeeeeseeeesreeeseeesveeeseeseneas 30

S90 XS/S70 XS AIE MY

J=n



Aol
F
[FAVORITE] wieieeeeeieeeeee et eeiee et e et e e 23
I RS 47
G
GM EO[A et 21
I
INPUT GAIN LEEE e 33
L
[LAYER] oottt st 28
LCD CONTRAST ittt et 17
(OB 1Y/ o Yo [ RS 45
1o = Lo TP 48
LOGIC PrO e 39
M
1S I =L 43
IMEIMIOTY ettt 43
Metronome = CHCK ..eviviiiieeeeriee e 45
MIC INPUT TEXE e 33
[MIC ON/OFF] ettt 33
Y1 = 37
Y = 37
[MIXINGT ceieeeeieeeeiee et ceeeesee e e e e e e e snee e e 38
[MULTI/SEQ PLAY] (HE| E2E) oo 38
[MULTI/SEQ PLAY] (A A HE BE) e 41
P
[PANEL LOCK] iieteiieieeeieeesiee e 46
Panel LOCK ... 46
[PART SELECT] cootiieetee ettt 32
e e 8
Power 0N MOAE ....eeiiiiiiieeeeee e 45
R
Reference Manual .....ccccocceeeeeereneinereeeeee e 8
S
S90 XS/S70 XS KHIE B weveeeeeeeeeeee e 40
SO0 XS/S7TO XS BZ Tl et 38
S90 XS/S7O XS B Z OITIE woveeeeeeeeeeeeee e 38
S90 XS/S70 XS LUAEIM e 38
[SHIFT] et 12
SONAR e s 39
S PSP 29
Studio Manager V2 ... 40
T
TrQQEr LeVEl i 34

XS/S70 XS A2 MdHAM

U
USB TO HOST TR et avaeee s 36
(O] SIS S 2N N [ 49
USB-MIDI E2}0|H(USB-MIDI Driver) ....cccoeeeceeeeeveeenes 36
V
[VOICE] ettt et e 21
S NI == i o 40
Z
Z0ONE SWITCN eetiteieieieie e e e e e e e e e e 44



zo)
2 EQ o] 20 A H2FM

LAZEQNE AESH| T 2 AZEL 0] 20| MA AFM(AAM)E XIMIS| HHAR. 2 AfMe| Z20| WatMTE 0] AZEYE AHESHE
EoE=AEHLL 2 AAM= AEXOHR! E= E 22t YAMAHA CORPORATION ('YAMAHA") Ztofl &2 & 2 4L ct.

m7|X|2] S2UE ES2M At Z2io| MEo| SSHA EUch =0l SSHA| F=CtH, AT ELNE EX|, ZALE= AESHA| O A 2.

=2 jetMe 2 MED 8 HE 2 M25= STEINBERG MEDIA TECHNOLOGIES GMBH(ISTEINBERGH) 2| iDAWT A I E ¢
SrL|CH IDAWT AZE Q0] AX| Al PC §tHO| EAIE= £F AFRX}
EUSLAE= 2 AlsHOF EfLICt &, AX| 2t-ol Al CtS HO|X|2 F0{7t2{H ALSXte| THetof 27| @10] EUSLAO IAGREE!

1. 20| MIA SI X{ZHH 20f

Yamahas AFSXH0IAH AZEY O T2 2 A2t &t M2 =]
= HOIEH('AZEQ")1RE A He|E R2HELICH AZEY N
gte 8= MEE AZEQ 0] X Hlo|Eof et YHO|EE Zatg
LICt 0] AZEQ 0= STEINBERG7} AR5HH 22 MAtHH 2 X
gt aie =oF 7ol 2fsh ESELICt Yamahas AFEXO| Al O AX
EQof ArE0fl thsl 2to|MAE 205tz MEZI0|MAE FERHEL
Ch AZEQ0 2 AHECZ MM E olo|E ol CH3H AL X} 2210 AR

M2 FHE 4 U AZESof B HEH ol5ho] X4
o BSELChAFBAHE 0 AZELI0IS § el ZHEE{oIM At
g8 4+ s

MEXH= AZEQ0{7} ST W A0l 58 == 0lc|ojol M e
0f US WDt el BXNOR I BEE £ Qe HAloz AnEY
0fo] AN S BHS 4 UELITH Q) ALZO| M= AFBAHE Yamaha
of W&t TXIE =R shof 50 AmEojo] Fl2o] HBEE AR

M2 ZH5OF BLICE

AFXHE ZHAO| AR S RS 24 2XITL AN E2S 9T
So|5tn MB 0t S| Y= ol 2 MIXLO| Al AZEL {0l Tt 2
£ H2l2 g7Noz osg 4 UL

2. Mgt x=A

L|Ct.

MEXHs ADEQ0S XA E= BEOR =, 4%, ©Y, (o],
oltf, Mo £ H{EE & glon, ANEYOZLE IHMSS OIS

= Ql&LCh

ALEXtz &t ZREOAM CHE HREHE AZEQYOE MANo=Z
E5t7LE HIEK IO CIE ZHEQA AZEJHE SRE & &
Lict.

AL8Xt= 2 HIOlH Y 33 FHS /8tsh= HIO|EE HZsts 2
ol ADEQOE AT 2 lELICH

A2 Xl= Yamaha Corporation?| {7} 10| AZE 0| AtZ0]| 7|tt
ot MHIAE Al&E 4~ gl&L T
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| NORTH AMERICA

CANADA
Yamaha Canada Music Ltd.
135 Milner Avenue, Scarborough, Ontario,
MI1S 3R1, Canada
Tel: 416-298-1311

US.A.
Yamaha Corporation of America
6600 Orangethorpe Ave., Buena Park, Calif. 90620,
US.A.
Tel: 714-522-9011

| CENTRAL & SOUTH AMERICA |

MEXICO
Yamaha de México S.A. de C.V.
Calz. Javier Rojo Gémez #1149,
Col. Guadalupe del Moral
C.P. 09300, México, D.F., México
Tel: 55-5804-0600

BRAZIL
Yamaha Musical do Brasil Ltda.
Rua Joaquim Floriano, 913 - 4' andar, Itaim Bibi,
CEP 04534-013 Sao Paulo, SP. BRAZIL
Tel: 011-3704-1377

ARGENTINA
Yamaha Music Latin America, S.A.
Sucursal de Argentina
Olga Cossettini 1553, Piso 4 Norte
Madero Este-C1107CEK
Buenos Aires, Argentina
Tel: 011-4119-7000
PANAMA AND OTHER LATIN
AMERICAN COUNTRIES/
CARIBBEAN COUNTRIES
Yamaha Music Latin America, S.A.
Torre Banco General, Piso 7, Urbanizaciéon Marbella,
Calle 47 y Aquilino de la Guardia,
Ciudad de Panam4, Panama
Tel: +507-269-5311

| EUROPE |

THE UNITED KINGDOM/IRELAND
Yamaha Music U.K. Ltd.
Sherbourne Drive, Tilbrook, Milton Keynes,
MK7 8BL, England
Tel: 01908-366700

GERMANY
Yamaha Music Europe GmbH
Siemensstrafle 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

SWITZERLAND/LIECHTENSTEIN
Yamaha Music Europe GmbH
Branch Switzerland in Ziirich
Seefeldstrasse 94, 8008 Ziirich, Switzerland
Tel: 01-383 3990

AUSTRIA
Yamaha Music Europe GmbH Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-60203900
CZECH REPUBLIC/SLOVAKIA/
HUNGARY/SLOVENIA
Yamaha Music Europe GmbH Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-602039025
POLAND
Yamaha Music Europe GmbH
Branch Sp.z o.0. Oddzial w Polsce
ul. 17 Stycznia 56, PL-02-146 Warszawa, Poland
Tel: 022-868-07-57

THE NETHERLANDS/
BELGIUM/LUXEMBOURG
Yamaha Music Europe Branch Benelux
Clarissenhof 5-b, 4133 AB Vianen, The Netherlands
Tel: 0347-358 040

FRANCE
Yamaha Musique France
BP 70-77312 Marne-la-Vallée Cedex 2, France
Tel: 01-64-61-4000

ITALY
Yamaha Musica Italia S.P.A.
Combo Division
Viale Italia 88, 20020 Lainate (Milano), Italy
Tel: 02-935-771

SPAIN/PORTUGAL
Yamaha Miisica Ibérica, S.A.
Ctra. de la Coruna km. 17, 200, 28230
Las Rozas (Madrid), Spain
Tel: 91-639-8888

GREECE
Philippos Nakas S.A. The Music House
147 Skiathou Street, 112-55 Athens, Greece
Tel: 01-228 2160

SWEDEN
Yamaha Scandinavia AB
J. A. Wettergrens Gata 1, Box 30053
S-400 43 Goteborg, Sweden
Tel: 031 89 34 00

DENMARK
YS Copenhagen Liaison Office
Generatorvej 6A, DK-2730 Herlev, Denmark
Tel: 44 92 49 00

FINLAND
F-Musiikki Oy
Kluuvikatu 6, P.O. Box 260,
SF-00101 Helsinki, Finland
Tel: 09 618511

NORWAY
Norsk filial av Yamaha Scandinavia AB
Grini Neringspark 1, N-1345 @sterds, Norway
Tel: 67 16 77 70

ICELAND
Skifan HF

Skeifan 17 P.O. Box 8120, IS-128 Reykjavik, Iceland
Tel: 525 5000

RUSSIA
Yamaha Music (Russia)
Office 4015, entrance 2, 21/5 Kuznetskii
Most street, Moscow, 107996, Russia
Tel: 495 626 0660

OTHER EUROPEAN COUNTRIES

Yamaha Music Europe GmbH
Siemensstrafie 22-34, 25462 Rellingen, Germany
Tel: +49-4101-3030

AFRICA |

Yamaha Corporation,

Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650

Tel: +81-53-460-2312

| MIDDLE EAST |

TURKEY/CYPRUS
Yamaha Music Europe GmbH
Siemensstrafle 22-34, 25462 Rellingen, Germany
Tel: 04101-3030
OTHER COUNTRIES
Yamaha Music Gulf FZE
LOB 16-513, P.O.Box 17328, Jubel Alj,

Dubai, United Arab Emirates
Tel: +971-4-881-5868

| ASIA

THE PEOPLE’S REPUBLIC OF CHINA
Yamaha Music & Electronics (China) Co.,Ltd.
2F, Yunhedasha, 1818 Xinzha-lu, Jingan-qu,
Shanghai, China
Tel: 021-6247-2211

HONG KONG
Tom Lee Music Co., Ltd.
11/F,, Silvercord Tower 1, 30 Canton Road,
Tsimshatsui, Kowloon, Hong Kong
Tel: 2737-7688

INDIA
Yamaha Music India Pvt. Ltd.
SF Ambience Corporate Tower Ambience Mall Complex
Ambience Island, NH-8, Gurgaon-122001, Haryana, India
Tel: 0124-466-5551

INDONESIA
PT. Yamaha Music Indonesia (Distributor)
PT. Nusantik
Gedung Yamaha Music Center, Jalan Jend. Gatot
Subroto Kav. 4, Jakarta 12930, Indonesia
Tel: 21-520-2577

KOREA
Yamaha Music Korea Ltd.
8F, 9F, Dongsung Bldg. 158-9 Samsung-Dong,
Kangnam-Gu, Seoul, Korea
Tel: 080-004-0022

MALAYSIA
Yamaha Music Malaysia, Sdn., Bhd.
Lot 8, Jalan Perbandaran, 47301 Kelana Jaya,
Petaling Jaya, Selangor, Malaysia
Tel: 3-78030900
PHILIPPINES
Yupangco Music Corporation
339 Gil J. Puyat Avenue, P.O. Box 885 MCPO,
Makati, Metro Manila, Philippines
Tel: 819-7551

SINGAPORE
Yamaha Music Asia Pte., Ltd.
#03-11 A-Z Building
140 Paya Lebor Road, Singapore 409015
Tel: 747-4374

TAIWAN
Yamaha KHS Music Co., Ltd.
3F, #6, Sec.2, Nan Jing E. Rd. Taipei.
Taiwan 104, R.O.C.
Tel: 02-2511-8688

THAILAND
Siam Music Yamaha Co., Ltd.
4,6, 15 and 16" floor, Siam Motors Building,
891/1 Rama 1 Road, Wangmai,
Pathumwan, Bangkok 10330, Thailand
Tel: 02-215-2626

OTHER ASIAN COUNTRIES
Yamaha Corporation,
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650
Tel: +81-53-460-2317

| OCEANIA

AUSTRALIA
Yamaha Music Australia Pty. Ltd.
Level 1, 99 Queensbridge Street, Southbank,
Victoria 3006, Australia
Tel: 3-9693-5111

NEW ZEALAND
Music Works LTD
P.O.BOX 6246 Wellesley, Auckland 4680,
New Zealand
Tel: 9-634-0099

COUNTRIES AND TRUST
TERRITORIES IN PACIFIC OCEAN
Yamaha Corporation,
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650
Tel: +81-53-460-2312

SY49

HEAD OFFICE

Yamaha Corporation, Pro Audio & Digital Musical Instrument Division

Nakazawa-cho 10-1, Naka-ku, Hamamatsu, Japan 430-8650

Tel: +81-53-460-2445
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